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P hotojournalism by definition is a particular form of photography 
that creates images in order to tell a news story.  It is       

distinguished by three characteristics: 
 
TIMELINESS - the images have meaning in the context of a recently 
published record of events   

 

OBJECTIVITY - the situation implied by the images is a fair and 
accurate representation of the events they depict in  content and tone 

 

NARRATIVE - the images combine with other news elements to make 
facts relatable to the viewer or reader on a cultural level. 

 
Capturing moments, memories, breaking news items or significant events and people with a story 
encapsulates the life of a photojournalist.  Composition, rule of thirds and lack of clutter important 
considerations in photography get somewhat trumped due to time constraints, which increases the 
necessity to be as efficient as possible in the photojournalism world. Also, out of oneôs control is the 
subject, location and circumstances of the story you are about to create.  Though this may seem a 
disadvantage, opportunities abound to be creativeé  as Ryan displayed to us through his photos and 
stories.   
 
Ryan is truly creative with use of light, one of the most important elements in photography.  He told us 
how and showed use examples of creative and dramatic lighting.   When possible, he takes the time to 
get this set up ahead of time when using speedlites, flashes or strobes.  Being the gadget guy he is, he 
showed us a variety of time lapse photographs of a piece of downtown over a span of  3 seasons taken 
with a camera he secured on the roof of the Edmonton Coast hotel, as well as overhead shots of world 
record dodge ball at the Butterdome.  The variety of his presentation photos was absolutely fascinating 
and from beginning to end he was very captivatingé so much so that I will consciously be looking for his 
work in future.   
 
Thank you Ryan for introducing us to the world of photojournalism with such enthusiasm.   

Ryan Jackson: Photojournalist and Story Teller! 
By Karrie Daly 

Self Portrait courtesy  
Ryan  Jackson 

Ryan is a multimedia photojournalist on staff with the Edmonton Journal were he works as a multimedia 
photojournalist.  His work can seen at the Edmonton Journal website or at his own website where he 
keeps a running update featuring production shots from the Edmonton Journal and his latest personal 
works.  There are many educational tips being posted there lately.  Check out Ryanôs exciting website at 
http://punkoryan.com/ 

http://www.edmontonjournal.com/
http://www.edmontonjournal.com/
http://punkoryan.com/
http://punkoryan.com/
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REMINDER: 
Wet/Muddy 
Footwear 

 

You must remove 
wet/muddy footwear 
before coming into 
the hall. If you bring 

a plastic bag for your 
boots and kept them 
under your chair it 
would really ease 
the congestion. 

The Editorôs Foreword 
By Fred Rushworth 

We have certainly had a varied program in February and I want to thank everyone who has sent me 
their articles and photographs so we can share these memories.   
 
This month, I have a recap of a couple of our mini-workshops just in time for the Devonian Gardens 
Outing.  There is early news from the Waterton Wildflower Festival and information about the Yousuf 
Karsh exhibit at our newly opened Art Gallery of Alberta. 
 
If you are looking for opportunities to show you images outside of the club, check out page 7 to find 
out about the Visual Arts Alberta open call for submissions.  You may also be part of a exhibit 
Images Alberta Camera Club  is hanging at the Royal Alexandra Hospital in August. 
 
Zbyszek has shared two more Photoshop tricks, this time using the Actions feature.  Of course, the 
newsletter is never complete without the display of  the winning images from last monthôs 
competition.  
 
Enjoy the read and happy shooting! 

Bob Bittner Photoshop Workshop Feb 7 2010  
Article and Photos By Barry Headrick 

Club member Bob Bittner is a landscape photographer who has several photos published in many 
prominent magazines.  Bob teaches a number of photography classes, including some full day 
Photoshop classes.  This three hour workshop was packed with information from one of his longer 
classes.  Bob explained how to adjust landscape images for maximum impact to the 
viewer.  Several techniques were covered in detail including selective sharpening and different ways 

to ñjuice upò an image without appearing unrealistic.   
 
Photoshop layers were the hot topic throughout the 
session.  Bob used Photoshop CS4 and he also described the 
corresponding methods in Photoshop Elements.  There were 
lots of questions and Bob addressed them thoroughly.  This 
was a lot of information to assimilate in three hours.   
 
The attendees left with a large pocket full of new ideas and 
techniques for their landscape photos.  Bob also provided 
sample images and a soft copy of the relevant parts of his 
handout from his Photoshop class.  Thanks, Bob!  
 

Open Board Positions 
 
We are still recruiting to fill the positions of the Outings and the Social coordinators for next season.  

So, pardon the puns;  if you are an social and outgoing person, please see any board member for 

details.  There are always plenty of experienced people to help you with these roles. 
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ñLook and think before 
opening the shutter. The 
heart and mind are the 
true lens of the camera.ò  

 
Yousuf Karsh,  

Canadian Photographer 

and Journalist 

1908 - 2002 

Winter Festival in Hawrelak Park 

Article and Photos by Carol Rusinek 

 

T his yearôs Silver Skate Festival, 
again, offered many photographic 

opportunities during the skating Marathon, 
Kortebaan, and Triathlon races. Other 
afternoon activities included figure skating 
demonstrations, sledge hockey, jam can 
curling, public skating, skiing, and snow 
shoeing. Many enjoyed a sleigh ride 
around Hawrelak Park or a treat at the 
Dutch center. Children loved the big ice 
slide and building forts with snow blocks 
and colored ice blocks.  
 
 

 
 
Snow sculpture creations were carved 
from huge blocks of compressed snow 
and were colorfully illuminated at night.  
 
 
 
The evening performances by Aboriginal 
dancers, Vibe Tribe, and various 
musicians were recorded and projected 
onto the giant snow screen as they 
performed. This is a true family festival 
every year. 

Vibe Tribe Dancers by Carol Rusinek 

The Race Is On by Carol Rusinek 

Time Travel at Ukrainian Cultural Heritage Village 
Article and Photos By Robert Stewart 
 

F ebruary 27, 2010, on a cloudy cool day, I went 
back in time; I travelled to the Ukrainian Cultural 

Heritage Village.  I met up with about 30 other 
enthusiastic members of the Images Alberta Camera 
Club.  We spent the day wandering the village with 
our cameras and tripods, on the hunt for the perfect 
shot. 
 
As we all began to arrive at the visitor reception 
centre, we met in the staff lunchroom, where there 
was coffee, tea, and hot chocolate for us before we 
started our journey for the day. 
 
It was about 9am when we loaded up our gear and headed through the doors and down the road to 
the past.  We all scattered in different directions, heading for the warmth of one of the many 

buildings, photographing the hundreds of historic 
artifacts, to capture details for artistic impression. 
 
At noon, with stomachs growling, we went to  the 
reception centre for lunch, and to have birthday cake:   
HAPPY BIRTHDAY SHEILA!   
After lunch we headed back out for the afternoon, each of 
us scattering to a different location, to find that perfect 
shot. 
 
For all who participated, the day went well.  Many thanks 
to Sheila for arranging this annual club event. 
 

Wostok Hardware Store (1937) By Robert Stewart 

The Mystery Filter  By Robert Stewart  



You must be an IACC member to attend Outings. 
Pre-registration is required and occurs at regular club meetings. 
If you have a suggestion for an Outing, please contact Carol Rusinek at 780.434.0456. 
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Saturday 
Mar 13, 2010 
9 amð2 pm 

Dog Sled Races 
Location: Mulhurst Bay on Pigeon Lake 
Arrive early to photograph in the "Barking Lot". 

Saturday 
Mar 13, 2010 
4 pmð10pm 

ILLUMINATIONS - Closing of the Winter Festivals 
Location: Edmonton Ski Club 9613 - 96 Ave  
Performers, lights, giant luge, pyrotechniques and fire monsters! 
www.winterlight.ca 

Sunday 
Mar 14 

11am-4pm 
DAYLIGHT 
SAVINGS 

TIME 

Devonian Gardens Winter Shoot 
Shoot winter scenes around the gardens. The display pavilions will also be 
open just for us.  Be at the gate for 11am.  The gates will be locked again 
after we enter.   The Devonian Gardens have requested that we provide 
them with some of our photos from this outing. 

ñThere is a brief 

moment when all there 

is in a man's mind and 

soul and spirit is 

reflected through his 

eyes, his hands, his 

attitude. This is the 

moment to record.ò  

Yousuf Karsh,  

Canadian 

Photographer and 

Journalist 

1908 - 2002 

Outings 2009 - 2010 
by Carol Rusinek, Outings Chair 

The monthly themes are the same for each of the 
categories (Slide, Digital, Small Print, Medium 
Colour Print, Large Colour Print and Monochrome 
Print). Members may submit up to 2 images in each 
category.   
 
Prints and slides must be registered, and digital 
images  received by 8 p.m. on the Tuesday night of 
the competition week. 
 
Complete guidelines, contact phone numbers or 
email addresses are listed on the Competitions 
Page on the IACC website  
imagesalberta.ca/program/competitions/. 

Monthly Competition Themes  
Reminder: 2 competition nights in April 

MAR 25, 2010 OPEN 

Apr  08, 2010 Wheels 

Apr 22, 2010 Annual Competition & 
Presidentôs  
Challenge Theme 
ñForensicò. 

Annual Competition Image Registration Due Apr 20 
At the end of each year, IACC has annual competitions. The categories are: 

Clive Mathewson Trophy 
Humour 
New Member of the Year 
Nortech Nature 
Outings 
President's Challenge: Theme is "FORENSIC" 
Workshops 
 
The entries are judged by three professionals on the evening of April 22rd. Entries are held in storage 
by the Competitions Committee until the AGM on May 27th. The entries are put on display and win-
ners are announced during the Year End Program along with the winners of the "Best Overall" in 
each monthly category. Additional information will be provided in the next newsletter.  
 
Please check our website at  http://www.imagesalberta.ca/files/annual_chart_2009.pdf  for details on 
sizing, matting, format and number of entries.  
 
If you have any questions, please contact Mary Wagner at 780.674.3923 or email iaccregistrations @ 
yahoo . ca. 

http://www.imagesalberta.ca/program/competitions/
http://www.imagesalberta.ca/files/annual_chart_2009.pdf
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Workshops 2009 - 2010 
By Gerry Wirun, Workshops Chair 

Saturday 
Mar 06/10  

 
9:30am-
12:30pm 

Provincial Archives of Alberta Tour and Workshop,  
with Terry O'Riordan, Audio/Visual Conservator.  
Behind the scenes tour and access to 2 million Alberta images.  
Learn about preservation of film and digital images .   
Location  - 8555 Roper Road  

You must be an IACC member to attend Workshops. 
 Pre-registration is required and occurs at regular club meetings.  

We need workshops on everything from technical to artistic, and  amateur to pro.  If you have any 

questions, comments, feedback, or if you or a friend can host a workshop please call GERRY WIRUN  at 

780.456.2717  or BARRY HEADRICK  at 780.461.4710 

ñI try to photograph 

people's spirits and 

thoughts. As to the soul-

t a k i n g  b y  t h e 

photographer, I don't feel 

I take away, but rather 

that the sitter and I give 

to each other. It 

becomes an act of 

mutual participation.ò  

 

Yousuf Karsh,  

Canadian Photographer 

and Journalist 

1908 - 2002 

By Pat Acheson    
7 PM at Pleasantview Hall unless noted!   (before the meeting)  

Mini Workshops Presentation Schedule 2009/10  

March 11 Miriam Stanisavljeviĺ 
Creativity in Photography 
Part 2 

March 25 Carol Rusinek Photo - Travel 

April 8 Open  Contact Pat to volunteer a presentation 

Apr 22 Club members (Display) 
Show and Tell : 
How you use photos 

 

Program 2009 - 2010 
By Karrie Daly, Program Chair 
 
Doors open at 7:00pm and meetings begin at 8:00pm unless otherwise 
noted.  

Mar 11/10 Guest Speaker: Greg Harvey : ñGoinô On A Safariò 

 

Member Showcase: Rae Emogene ñPhotographic Potpourriò 

Apr 22/10 IACC ANNUAL COMPETITIONS 

PRESIDENT'S CHALLENGE:  THEME "FORENSIC" 

May 13/10 Guest Speaker: Gord Heatley (NAIT 2nd year Photography student                        
awarded IMAGES 2009 scholarship) 
Member Showcase: Colette Panaioti ñScotlandò 

May 27/10 

6:30 pm. 

IACC AGM (Annual General Meeting) 
6:30PM Year-end Potluck Dinner 
Annual General Meeting 
Annual Competition Awards 
IACC Group Showcase. 
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"Within every man and 

woman a secret is 

hidden, and as a 

photographer it is my 

task to reveal it if I can. 

The revelation, if it 

comes at all, will come 

in a small fraction of a 

second w ith  an 

unconscious gesture, a 

gleam of the eye, a 

brief lifting of the mask 

that all humans wear to 

conceal their innermost 

selves from the world. 

In that fleeting interval 

of opportunity the 

photographer must act 

or lose his prize." 

Yousuf Karsh,  

Canadian 

Photographer and 

Journalist 

1908 - 2002 

  

Waterton Wildflower Festival, June 19-26, 2010. 
Text from  Waterton Wildflower Festival website: www.watertonwildflower.com 

 
The spectacular setting of Waterton Lakes National Park is home to more than 50 per cent of 
Alberta's wildflowers... more than any other Rocky Mountain national park. Over 50 of Canada's rare 
flowers grow in Waterton, 30 of which are found only in this park.  From beargrass to orchids, nature 
is on display in a panorama of blossoms among prairies and peaks. This amazing diversity of 
wildflowers will be celebrated in the sixth annual Waterton Wildflower Festival, June 19-26, 2010.  
Join us for guided flower walks, hikes or workshops, celebrate the first day of summer in a World 
Heritage Site. Activities for all ages. 
 
This 9-day event features more than two dozen educational courses on wildflowers, plants and 
ecosystems, art exhibits; workshops on photography and art, and evening slide shows and local 
entertainment. Courses include: Wildflower Identification, Wildflower Habitat, Bird Watching, 
Wildflowers by Horseback and by Cruise Boat, Photography Workshops, Watercolours, Afternoon 
Tea and much more. 
 
Activities throughout the 9 days are led by highly qualified professionals including talented wildflower 
photographers Paul Gilbert (author of "Wild Colours" and "Wild Light" books), Steve Harrington and 
Frans Brouwers; Calgary Zoo Botanical Education Coordinator, Jane Reksten; naturalists and 
scientists, Dr. John Dormaar, Dr. Brian Reeves, Jo-Anne Reynolds, Mira Vanhala; bird expert, Peter 
Sherrington. 
 
The complete program  details and registration should be published later in March.  Check the 
website for the latest details.  http://www.watertonwildflowers.com/   or call 1-800-215-2395  

Focus On Flowers 
A compilation from Gerry Harrisôs ñMacroò and Alvin Baragarôs & Leota Cumminsô ñFlowersò mini workshops. 
 

Here are a few reminders from our mini-workshops to prepare you for this monthôs outing to the 
Devonian gardens: 
 
There are three options for SLR cameras to allow you to work closer and get more detailed shots.  
From least expensive to  most expensive (generally), they are:  

Close-up filters screw onto the front of your lens and allow the camera to focus closer to the 
subject.  Filters can be stacked for greater magnification but image quality drops as more 
magnification is added.  The image edges may go soft.  

Extension tubes also provide magnification without having to move closer but reduce the light 
entering the camera.  You will need to reduce your shutter speed, use a smaller aperture 
(bigger f-number)  or a higher ISO.  Slower shutter speed means more risk of motion blur.  A 
smaller aperture means you will lose your soft backgrounds  because more is in focus.  A 
higher ISO may increase grain or noise to your image, depending upon you camera. Some 
extension tubes may not allow auto focus and  reduce the light in your viewfinder making it 
difficult to manually focus.  

Macro lenses can be purchased on differing focal length and degrees of magnification.  Macro 
lenses provide magnification without having to move close.  This is important with insects where 
you donôt want to disturb them.  Macro lenses usually  allow much more light into the camera. 

 
Point and shoot camera users may find their macro option allows a closer focusing distance allowing 
the camera to be closer  and the resulting image to be larger on the sensor. 
 
Alvin prefers to use a lens with a f-stop of f2.8.  This aperture size creates a shallow Depth Of Field 
and allows the background to go out of focus and not distract from the flower. 
 
Tripods provide stability.  This is important because the shallow Depth Of Field of macro 
photography means slight movement of the camera closer to,  or further from,  the subject  will make 
you lose your focus. 
 
Use side lighting to capture texture or detail.  Use backlighting to capture light through the fine 
translucent petals on flowers like poppies and columbine  Flowers like lilies, with more substantial 
petals, don't show as well with backlighting 
 
Shoot patterns such as you may find  in grasses or leaf veins or use contrasts such as flower 
against leaf or wood grain or  burnt stumps. 
 
The most important parts of the flower to have in focus are the stamens and pistil.  Get those crisp 
even at the expense of  petals and leaves.   

http://www.watertonwildflowers.com/
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"My chief joy is to 

photograph the great in 

heart, in mind, and in 

spirit, whether they be 

famous or humble."  

 

Yousuf Karsh,  

Canadian Photographer 

and Journalist 

1908 - 2002 

VAAA Call For Entries: Open Photo 2010 
DEADLINE FOR SUBMISSION: MARCH 15, 2010 
Open to all Alberta artists working in any still photographic media 
 
Visual Arts Alberta Association is inviting all Alberta artists to submit still photographic images. All 
subject matter, style and technical processes are welcome.  First place prize winner will be given a 
solo exhibition in Edmontonôs Tu Gallery. Additional awards and recognition to be announced. The 
exhibition will be held at the Jubilee Auditorium in Edmonton in June to July 2010 (exact dates TBA). 
Successful applicants will be notified by Friday, April 15, 2010.    
 
Images member, Jim Gaa had photographs displayed in last yearôs exhibition.  He was also invited to 
display at a second show this past fall. 

 
Submission details at : Open Photo 2010 Submission Requirements & Application Form 

Karsh: Image Maker, Exhibit at AGA until May 30 
By Fred Rushworth 
 
In the twentieth century, Canadian photographer Yousuf Karsh captured the image of some of the 
worldôs most famous actors, athletes, politicians, and royalty. While Karsh described what he did as 
capturing a ñmoment of truth,ò his photographs were the result of several deliberate artistic and 
technical decisions.   It is said that Karsh moved portrait photography from flat lighting by introducing 
elements of stage lighting such as would be used in theatre .  His use of back lighting and light 
shaping can be seen as the beginnings of portrait lighting as is practiced today. 
 
His work is represented in the permanent collections of the Metropolitan Museum of Art and the 
Museum of Modern Art in New York, the Philadelphia Art Museum, the Art Institute of Chicago, the 
National Gallery of Canada,- the National Portrait Gallery, London, and other leading museums.  
Now you can view some of Karshôs images and learn more about Karshôs method for revealing these 
ótruthsô about his subjects until May 30 right here in Edmonton at the new Alberta Gallery of Art.    
 
The Ottawa Citizen newspaper ran a series of articles on Karsh, his influences and stories from 
readers about their own Karsh portraits and their memories of the man.  I feel  their  website link is 
well worth exploring before your make your visit to the  show  at AGA in Edmonton. 
  http://www.ottawacitizen.com/news/karsh/index.html  

Call for Submissions: Royal Alex Hospital Exhibit 
By Fred Rushworth 
 
Images Alberta Camera Club has again been selected to hang a gallery show this August in the food 
court exhibition area at the Royal Alex Hospital.  This is a high traffic area and  an excellent 
opportunity to promote your photography! 
 
This show is open to all IACC members and is limited to 31 photographs, preferably, one per 
member.  Your photograph will be for sale and 20% of the purchase price will go to assist the Royal 
Alexandra Hospital Foundation.  
 
Photographs exhibited must be framed  and the frame must be larger than 11ò x 14ò but not to 
exceed 16ò x 20ò.  You images must be of high quality and be acceptable for family viewing and 
suitable to display in a hospital setting.  You must assist to hang the gallery August 2nd and take 
down August 30th or have a designated person to do this on your behalf. 
 
More information about this show and a sign-up sheet will be available later this month.  We must 
have all of our artistôs release forms and show details completed and submitted by May . 
 

Volunteer Photographers Required:  
Rona MS Bike TourðLeduc to Camrose June 12 & 13 

We have had no response to this volunteer request.  If you are interested, please call Janet Bennett at 

780-461-7548  and introduce yourself as a member of Images Alberta Camera Club. 

http://visualartsalberta.com/blog/?p=10858
http://visualartsalberta.com/blog/wp-content/uploads/2010/02/openphoto2010.pdf
http://www.ottawacitizen.com/news/karsh/index.html
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ñCharacter, like a 

photograph, develops 

in darkness.ò  

Yousuf Karsh,  

Canadian 

Photographer and 

Journalist 

1908 - 2002 

Zbyszekôs favorite Photoshop tricks (Part 3) 
By Zbyszek Gortel 

Screen shots created from Adobe Photoshop CS3 by Fred Rushworth 

Actions: 
 
Creating an action involves recording a series of  steps to do some specific task in Photoshop. Once 
recorded, one just plays the action and the steps are executed quickly on any image.  This is a great 
time-saving and error-avoiding method 
 
Start by making your Actions panel visible.  Open Photoshop and in the Menu bar select Window > 
Actions. A small panel window pops out with the HISTORY and ACTIONS panels. You may separate 
the two panels so both are visible at the same time or keep them together and access the one 
needed by clicking its name.  
 
Make your ACTIONS panel larger by dragging one edge out to make it is easier to see what the 
panel contains.  By default, it contains several Actions provided by a Adobe grouped into a set 
ñDefault Actionsò.  If they are showing, click on a triangle to the left of a symbol of a folder to the left 
of the ñDefault Actionsò name to collapse the list of actions in this set so they are out of our way.   
 
 
There are 6 icons at the bottom of the Actions panel. 
Counting from the left they are (their shapes in brackets): 
Stop playing/recording (square); Begin Recording (circle); 
Play Selection (triangle); Create New Set (shape of a 
folder); Create New Action (square with folded corner); 
Delete (garbage can). 
 
 
To create a ñprivateò set in which your own actions are stored, click the ñCreate new setò icon.  A 
small dialogue window pops out in  which you type the name of the set (I typed ñZWG Actionsò. Click 
OK. The new (empty so far) set appears in the Actions panel.  
 
Now, we have all elements needed to create our own action.  I will show this on two examples being 
somewhat modified procedures which we have learned at the last Bob Bittner workshop:  ñHigh Pass 
Filter sharpeningò and ñSelective lightening and darkeningò .  
 
High pass filter sharpening action 
 
I have modified the procedure which Bob Bittner described in his workshop. This allows preview of 
the sharpening while doing it and change its parameters after the fact (i.e. rendering it as if it were 
editable adjustment layer). I assume that the image opened has only a Background Layer. 
Sharpening can be done on a multi-layer image but the layer which is active while the action is 
played must contain actual image pixels (or the part of the image to be sharpened). The ñsmartò part 
(Step 4) will not work with Photoshop version earlier than CS3. Do not worry. Just skip the Step 4 
from the description given below. 
 
1. Click ñCreate New Actionò icon. In the dialogue panel 
which opens enter ñHigh Pass Filter Sharpeningò in the 
ñName:ò field. In the ñSet:ò field select the set just created 
(ZWG Actions in my case). Ignore the rest and click in the 
ñRecordò button in this window. 
 
Every step you execute from now on is executed on the 
opened image and recorded so plan carefully what you want to do. If you make an error, you should 
stop recording (click in ñStop playing/recordingò icon at the bottom of the Actions), go back in the 
History panel to the starting point, pull the aborted action into the garbage can, and start from the 
beginning). 
 
2. Photoshop Menu bar: Layer > New > Duplicate Layeré  
 
In the dialogue box which opens enter: ñHigh Pass Sharpenò in the ñName:ò field. Leave all else 
unchanged and click OK. This creates the exact copy of the Background Layer (or of the layer we 
want to sharpen). 
 
3. Change the layer mode to ñOverlayò (in the Layers panel, while the created 'High Pass Sharpenô 

Layer is selected). Do not worry that the image becomes terrible. 

The 6 Icons along bottom of Actions Panel 

New Action Dialog Panel 
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ñThe trouble with 

photographing beautiful 

women is that you never 

get into the dark room until 

after they've gone.ò 

Yousuf Karsh,  

Canadian Photographer 

and Journalist 

1908 - 2002 

Zbyszekôs Favorite Photoshop Tricks ...continued 
 
4. Photoshop Menu bar: Filter > Convert for Smart Filters 
 
Click OK in the Information box if it opens.  Wait a while. The newly created layer becomes ñsmartò which 
will allows it to be edited any time in the future as if it were an Adjustment Layer.  You recognize the 
smartness of the layer it by the appearance of its icon in the Layers panel. 
 
5. Photoshop Menu bar: Filter > Other > High Pass 
 
A dialogue box opens with a small preview of the image (totally useless).  
Enter 3 (pixels) in the ñRadius:ò field and click OK. After a while, the 
sharpening is done and the ñHigh Pass Sharpenò layer gets appended by a 
ñSmart Filtersò sub-field, and a High Pass sub-sub-field (look at the Layers 
panel to see what I mean) 
 
6. Click ñAdd vector maskò icon (grey rectangle with a white circle) at the 
bottom of the Layers panel.  
 
7. Click in the ñStop playing/recordingò button (in the Actions panel). This completes the recording. 
 
8. In the list of steps that you see under the name of the new action in the Actions panel, there is a step 
called ñHigh Passò (created in Step 5). There are a triangle and an empty ñembossedò rectangle to the left 
of this name.  Click into the rectangle. It fills with a grey frame with 3 dots inside (similar icon in red 
appears in an embossed rectangle to the left of the name ñHigh Pass Sharpenò). This is a pause stop so, 
when you play the action,  it tells the program to pause when the High Pass dialogue window is opened to 
allow you to change the radius value before continuing with playing the rest of the action. 
 
Testing: Go back in the History panel to the point before the action was recorded, highlight the action 
name in the Actions panel and click the ñPlay selectionò icon there. It will take some time to go through all 
the steps.  The execution pauses at the High Pass dialogue window. Move 
the ñRadiusò slider and observe the image at 50%. Move the slider to a 
ridiculously high value of 250 pixels. The image gets terrible but do not worry, 
we are only testing the action. Click OK. The action completes ï it takes 
some time. Activate now the mask of the ñHigh Pass Sharpenò layer and paint 
with Black into the image with a 100% opacity brush. You should see that the 
painted part of the image gets restored to its original appearance. If it does, 
the action is all right. Only the visibility ñeyeò to the left of the new layer name 
is useful for checking the before/after effect.  A triangle to the right of the 
name allows to collapse the subfields into and out the layer.  
 
Now the most important thing: double click on the  subfield ñHigh Passò name (not on the layer icon) in the 
layers panel.  It reopens the high pass filter dialogue box in which you can change the pixel radius while 
watching the image (at 50% is recommended). This feature makes the ñHigh Pass Sharpenò layer 
editable.   
 
If you have a Photoshop version earlier than CS3 you skip the Step 4 while recording the action. Still, 
select 3 pixels in Step 5. Then, the  Radius pixel size which you select while playing the action when it 
pauses at the High Pass filter dialogue box will be the final one without the possibility of  changing it after 
you finish. You must carefully observe the image while moving the slider before you decide what value to 
commit to.  You may want to run the same action several times with different Radii (starting always from 
the same image layer) and use the Snapshot feature in the History panel to compare the results and 
deleting  all created ñHigh Pass Sharpenò layers except the ñbestò one. 
 
Selective lightening and darkening action 
 
The action creates two new adjustment layers with black masks each. The lower layer will be in the 
Screen and the upper  one in the Multiply mode. The action selects also a Brush tool. After playing the 
action you will have to select color (white), a size (depending on the image), and an opacity (typically 10-
30%) of the Brush. Selecting the lower layer mask (the one in the Screen mode) and painting over the 
image one lightens the painted portion of the image. Doing the same after selecting the mask of the upper 
layer (the one in the Multiply mode) darkens the painted portion of the image. 
 
Before recording, make sure that a Brush tool is not selected (for example, click into the Rectangular 
Marquee tool).  Otherwise, Photoshop will not record Step 5.  
 
1. Open any image (it does not matter how many layer it already contains but I assume that it has only a 
Background layer). 
 
 
 

Layers panel for step 5 
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Yousuf Karshôs  brother, 

Malak Karsh, was also a 

photographer famous 

for the image of logs 

floating down the river 

on the Canadian one 

dollar bill.[5]  

Historian on Holiday 
By Mufty Mathewson 
 
There is no article history of Images this month as I am in Tuscon, Arizona. We heard of someone 

who wanted to do a house exchange so Bill and I are doing just that. But I will be active 

photographically. Because Images is a member of PSA, (therefore so am I), I looked up 

PSA's website, found two camera clubs in Tuscon and invited myself to a meeting of each.  Both 

were most welcoming. I also offered to bring some Canadian Rockies pictures with me in the little 

slide show I made for Jasper last year and was encouraged to present them to the Desert 

Viewfinders Camera Club.   

I have done this before while visiting a new city or town and have always been welcomed. I might add 

that comparing Images Alberta Camera Club to the ones I have visited, I have always found Images 

to be right up there with the best. 

 More Images history next month! 

Zbyszekôs Favorite Photoshop Tricks ...continued 
 
2. Click the ñCreate new actionò button at the bottom of the Action Panel.  
 
In the dialogue window which opens enter ñCreating lightening/darkening layersò in the ñName:ò field. 
In the ñSet:ò field select the set just created (ZWG Actions in my case). Ignore the rest and click in the 
ñRecordò button in this window. 
 
3.  Photoshop Menu bar: Layer > New Adjustment Layer > Levels  
  
In the dialogue window which opens: type ñLightening layerò in the ñName:ò field, select ñScreenò from 
the drop down menu besides the ñMode:ò field, and click OK. This creates a new layer called 
ñLightening layerò with a white layer mask. The mask is active (it is surrounded by a frame, click into it 
if it is not active). To fill it with black, press ñCmd-iò (Ctrl-i on PC). 
 
4. Photoshop Menu bar: Layer > New Adjustment Layer > Levels 
 
Do the same as in Step 3 except that the name should now be  ñDarkening layerò and the layer mode 
should be changed to ñMultiplyò. After clicking OK, press Cmd-i to fill the layer mask with black. 
 
5. Select the Brush tool from the Tools panel (you can do that by pressing a B key as well). If the 
Brush tool was already selected, then select some other tool (like Lasso)  and then select Brush. 
 
6. Click in the ñStop playing/recordingò button (in the Actions panel). 
 
This is it. As far as I know, one cannot record the brush size, opacity, etc. Examine the list of  steps of 
the new action as they are listed in the Actions panel. You can collapse the list by clicking a triangle to 
the left of the name of the created action. 
 
Testing (do not ignore this).  In the History panel go back to ñOpenò. Then, in the Actions panel,  select 
the ñCreating lightening/darkening layersò (i.e., click the name of the action which has just been cre-
ated). The action gets highlighted. Then, click in the ñPlay selectionò icon (at the bottom of the Actions 
panel). It takes less than a second to play all the steps. The image does not change visually because 
both masks are black but you can see what the two layers do by right-clicking in one of the black 
masks and selecting ñDisable Layer Maskò from the drop down menu. The image either brightens or 
darkens considerably (and its contrast considerably decreases or increases, respectively) depending 
on which of the two masks is disabled. To re-activate the Layer mask, click into it.  
 
 
IV. Coming up soon      
 
Shadows/Highlights as an editable Adjustment Layer. 
My favorite monochrome (B&W, sepia, etc.) procedure. 
How to find the center of an image. 
Using Lab color space to punch up colors in weak images. 
Creating masks from images and poor manôs HDR  

http://en.wikipedia.org/wiki/Malak_Karsh
http://en.wikipedia.org/wiki/Withdrawn_Canadian_banknotes#One-dollar_bill
http://en.wikipedia.org/wiki/Withdrawn_Canadian_banknotes#One-dollar_bill
http://en.wikipedia.org/wiki/Yousuf_Karsh#cite_note-Malak-4
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Competition Results ðFebruary 2010: MOTION 

 

 DIGITAL    SMALL PRINT  

1 Wonderful Wind Quincey Deters  1 Speed Fred Rushworth 

2 Sploosh! Shirley Coulson  1 Inch By Inch Sieg Koslowski 

3 Getting Dizzy Miriam Stanisavljeviĺ  2 Hot August NIght Dianne Fuson 

    2 Match Stick Rae Emogene 

    3 Sway Miriam Stanisavljeviĺ 

 SLIDE      

1 Spin And Spray  Calvin Binnema   MEDIUM  

2 Hoop Jugglers  Sieg Koslowski  1 Hoopla Sieg Koslowski 

3 Niagara Falls 
B.C.  

Leotta Cummins  2 Making Waves David Aldana 

    3 Wipeout Sieg Koslowski 

       

 MONOCHROME    LARGE PRINT  

1 Taking Off Zbigniew Gortel  1 Furious Zbigniew Gortel 

2 Airborne Zbigniew Gortel  2 Leap Year Sieg Koslowski 

3 Cool Waves Bill Vanden Born  2 Geronimo! Sieg Koslowski 

3 Olympic Moment Sieg Koslowski  3 David Aldana Dragon Run 

óGetting Dizzyô  By Miriam Stanisavljeviĺ  

óSpin And Sprayô By Calvin Binnema 

óWonderful Windô By Quincey Deters 

óHoop Jugglersô By Sieg Koslowski 

óMatch Stickò 

 By  

Rae Emogene 
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Competition Results ðFebruary 2010: MOTION 

óSpeed ó By Fred Rushworth 

óSplooshô By Shirley Coulson 

óHot August Night ô By Diane Fuson  

óInch By Inch ô By Sieg Koslowski  

óMaking Wavesô By David Aldana 

óHooplaô  By Sieg Koslowski 

óSwayô By Miriam Stanisavljeviĺ  

óWipeout!ô By Sieg Koslowski 


